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TECNICAS

Tutorial de preparacao de mapas de distribuicao geografica
Parte II - Mapa Hipsométrico

Barbara B. Calegari'* & Joao Pedro Fontenelle®

apas de distribuicdo geografica de taxons,

dentro do contexto bioldgico, muitas vezes
requerem expressar diversas variaveis e informagdes
abidticas, além de meramente oregistro de localizagao
das entidades. Esse ¢ o caso de, por exemplo, a
exploracdo de caracteristicas topograficas como a
altitude, ilustradas nos mapas, as quais por vezes sao
muito importantes como um indicador da aparéncia
geografica e geoldgica.

A hipsometria ¢ uma técnica de representacao
da elevacdo de um terreno através de um sistema
de gradiente continuo de cores correspondentes.
Geralmente utiliza-se um gradiente de cores frias
(ex. verde, azul) para representar baixas altitudes
e cores quentes (ex. vermelho, laranja) para
representar altitudes mais elevadas do relevo. Os
estudos de hipsometria permitem conhecer mais
detalhadamente caracteristicas do relevo de certa
regido, possibilitando ainda inferir processos
erosivos, identificagdo de arecas de inundacao,
depressoes, etc.

Por este motivo, ¢ apresentado a seguir um
segundo Tutorial passo-a-passo, complementar
ao “Tutorial - Parte I” publicado anteriormente
neste boletim (Boletim Sociedade Brasileira de
Ictiologia, N° 118), elaborado no intuito de retratar
e personalizar especificidades da altitude e relevo
de forma facil. O presente tutorial para preparagao
do mapa hipsométrico foi elaborado e testado
utilizando o programa Quantum Gis V.2.14.5 ¢
V.2.14.18 (QGIS: software de sistema de informacao
geografica - SIG, em portugués; GIS-em inglés), que
pode ser gratuitamente baixado através do site http://
www.qgis.org/pt_PT/site/.

Este tutorial foi elaborado nas versdes
Portugués e Inglés, esta ultima sendo apresentada
por conseguinte.

O presente tutorial foi elaborado de forma
simples, ndo para uso profissional de sistema
cartografico, mas voltado a parte educacional em

auxiliar alunos, professores e pesquisadores a
elaborarem seus mapas de distribuigdo geografica
e, portanto, ndo deve ser utilizado como unica fonte
de base do aprendizado. Todos os programas e sites,
aqui utilizados, tém seus direitos de propriedade ao
conteudo e criagao dos seus arquivos e softwares,
os quais sao devidamente citados neste tutorial e
recomendados para que sejam também citados nos
artigos cientificos em caso de utilizagao dos mesmos,
atribuindo assim seus direitos legais.

Parte I - Baixando arquivos base

Passo 1: arquivo de relevo Raster

Nessa primeira parte iremos aprender a editar
a camada de relevo do mapa, inserindo diferentes
cores para distintas categorias de altitudes e também
selecionar quais e quantas classes de altitudes vocé
deseja para o mapa.

Iremos trabalhar com arquivos raster
(.tif) de relevo continuo fornecido pelo Geoportal
“The CGIAR Consortium for Spatial Information
(CGIAR-CSI)”, que podem ser baixados no endereco
http://srtm.csi.cgiar.org/ (Fig. 1); vocé devera ser
redirecionado para uma nova pagina onde sera
necessario escolher a regido mundial de interesse, no
caso a América do Sul: “Western”; baixe o arquivo
“western GeoTIFF” (Fig. 2).

O Geoportal CGIAR fornece arquivos de
modelo digital de elevagdao das terras do globo
inteiro SRTM (Shuttle Radar Topography Mission)
de 250m de resolucdo, produzidos originalmente
pela NASA. Estes dados sdo distribuidos de forma
gratuita pela USGS (U.S. Geological Survey; https://
viewer.nationalmap.gov/launch/) na rede mundial de
computadores e esta disponivel para baixar através
do “National Map Seamless Data Distribution
System” ou USGS site (https://nationalmap.gov/
viewer_text.html; Fig. 3).
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Outra opg¢do, que ndo iremos utilizar aqui,
¢ para quem deseja trabalhar especificamente com
uma especifica regido geografica, em maior escala,
podendo obter dados através do projeto TOPODATA
(Bancos de dados geomorfométricos do Brasil;
INPE, 2008), o qual oferece o Modelo Digital de
Elevagdo (MDE) e suas derivagdes locais bésicas
em cobertura nacional, também elaborados a partir
dos dados espaciais SRTM, que passaram por
sucessivas inspe¢des e aprimoramento, uma vez
que este ultimo por vezes apresenta espagos vazios
no mapa, causados por interferéncias durante o
processo de coleta de dados durante sua elaboracao

(exemplo de falhas e como corrigir no tutorial
online: goo.gl/FHcqFA). Estes dados individuais
podem ser baixados no INPE pelo endereco http://
www.dsr.inpe.br/topodata/acesso.php (Fig. 4) ou
na pagina Webmapit http://www.webmapit.com.
br/inpe/topodata/ (Fig. 5), bastando selecionar a
quadricula desejada. O processo de elaboragao deste
tipo de mapa com re-escalamento das categorias
de altitude ¢ mais complexo do que iremos ensinar
neste tutorial, mas tutoriais podem ser facilmente
encontrados online realizando uma busca por “Mapa
hipsométrico”.
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Passo 2: arquivo de modelo altimétrico

Para facilitar a elabora¢ao de um mapa de distribui¢ao
geografica simples com relevo contendo informacgao
de altitude editavel, iremos partir de um modelo
digital de elevacao pré-existente desenvolvido e
disponibilizado pela pagina http:/www.webmapit.

[PV

provenientes do software GRASS (funcdo ‘r’,
colors) (Webmapit, website, acessado em nov/2017).
Adicionalmente, também disponibilizamos dois
modelos prontos por nds elaborados, um em
tonalidades de Marrom e outro elaborado durante
este tutorial, podendo ser acessado aqui (goo.
gl/7iPg21) ou em http://www.barbara-calegari.com.

com.br/, os quais podem ser baixados no blog do
mesmo site (http://blog.webmapit.com.br/2013/02/
topodata-paletas-ggis-para-altitude.html) e
posteriormente descompactados. Os arquivos de
extensao “.qml” usados nesse tutorial, sdo modelos
que categorizam rampas de cores para a variavel
altitude e foram elaborados pelo Webmapit a partir
da adaptacdo dos valores de elevacdo e regras de
cores SRTM: Terrain, Atlas Shader, ¢ ETOPO2;
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Figura 6.

Para adicionar o arquivo relevo de uma fonte

tipo Raster, sera necessario clicar no segundo icone

®. na barra de ferramentas lateral esquerda, da

mesma forma como inserido o arquivo de relevo
plano, ensinado no “Tutorial I’ (Fig. 7).

Busque no seu diretério, o arquivo
anteriormente salvo nomeado >SRTM W _250m.
tiff. Ordene a camada de relevo para a ultima posi¢ao
mais abaixo, de maneira que ndo sobreponha as
demais camadas. Clique com o botao direito sobre a
camada do relevo nomeada “SRTM_W_250m” e va
em >Propriedades (>Properties) (Fig. 8).

EEfs-

Parte II - Criando Mapa Hipsométrico

Partindo de um mapa de distribuicao
geografica ja elaborado nos moldes do “Tutorial
I” publicado previamente neste mesmo boletim (N°
118), exceto pela adicao do arquivo do relevo (Fig.
6), avangcamos diretamente para a segunda parte da
edi¢ao da camada de relevo.

- oER

Na aba “Estilo” (“Style”) dessa janela,
existe a se¢do “Renderizacdao da banda” (“Band
rendering”) (Fig. 9), a qual iremos trabalhar maior
parte deste tutorial, onde € possivel editar diversas
caracteristicas relacionadas ao colorido.

Perceba que o arquivo de relevo aberto
aparece como uma imagem em escala de cinza, ndo
informativa. E necessario entdo aplicar uma rampa
de cores adequadas para acentuar a topografia do
mapa. Existem duas opcles de atribuir cores as
classes de altitude, mas em qualquer uma delas ¢
necessario primeiro ir em “Tipo de renderizacdo”
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(“Render type”) e selecionar >Banda simples falsa-
cor (>Singleband pseudocolor), que permitira
atribuir escala de cor ao mapa (Fig. 10). Deixe
também a opcao “Cor de interpolagdo” (“Color

interpolation”) selecionada para >linear para que as
cores atribuidas correspondentemente as altitudes
mudem gradualmente, permitindo um visual mais
suavizado (Fig. 11).
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A primeira opcao e a mais facil, é editar o arquivo de modelo altimétrico. Basta carrega-los
gradiente de colorido a partir de um modelo digital na por¢do inferior da janela em >Estilo > Carregar
de elevacao pré-existente; escolha um dos seis estilo (>Style >Load style). Os arquivos modelo de
modelos disponibilizados ja baixados no Passo 2: relevo editaveis sao de extensao “.qml” (Fig. 12).
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Figura 12.

Vocé pode abrir todos os arquivos e ver vamos exemplificar utilizando o arquivo “Altitude
qual se adéqua mais a idéia de cores que deseja Continente.qml” elaborado para este tutorial (Fig.

desenvolver na camada de relevo. Para editar, 13).
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Apbs escolher o modelo, va na segdo
“Carregar valores de min/max” (“Load min/max
value”) e selecione >Min/max para atribuir os dois
extremos das altitudes; e também em “Precisdao”
(“Accuracy”), selecione >Real (mais lento) (>Actual
(slower)), de modo que representara as altitudes
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Figura 14.

Vocé ainda pode modificar quantas classes
de altitudes deseja incorporar ao mapa, podendo
excluir ou incluir gradientes. Iremos incluir, por
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Figura 15.
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QGIS 2.14.5-Essen - tutorial mapa

reais do terreno; clique em >Carregar (>Load).
Este processo pode levar um tempo consideravel,
dependendo das suas configuragdes de hardware,
devido ao tamanho do arquivo. Vocé pode clicar em

>Aplicar (>Apply) para visualizar as edigdes feitas
(Fig. 14).
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exemplo, uma classe adicional de 100 m; no quadro
branco de valores das altitudes va no simbolo “+”
para adicionar um novo valor ao mapa (Fig. 15).
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SBI
Note que o novo valor foi adicionado ao final valor igual a zero “.00000”, como nos demais valores
da lista com uma cor aleatoria. Para atribuir o valor ali apresentados. Neste caso, iremos inserir uma cor
de altitude que deseja corresponder a cor, clique para a escala de altitude de 100 m. Em seguida,
duas vezes em cima do valor (expressado em metros) clique no simbolo “\/” para que o valor seja
e edite-0; ndo esqueca de manter a série decimal com reordenado de forma ascendente (Fig. 16).
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Figura 16.

Clique em cima da cor para edita-la, e classe inserida; neste caso “100” (Fig. 18). Isso
escolha a cor e tonalidade desejada de acordo com porque uma opg¢ao seria colocar o intervalo (por
o gradiente que deseja; neste caso, verde (Fig. exemplo, 100-200 m) para todas as classes, ao invés
17). Além disso, sera necessario editar o “Rotulo” do valor minimo. Clique em >Aplicar (>Apply) e
(“Label”) indicando a altitude correspondente da >Qk. Para excluir basta selecionar a classe e clicar

no simbolo “-” (Fig. 19).
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Figura 17.
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Figura 18.
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Figura 19.

Adicionalmente ¢ possivel trocar qualquer
uma das cores de qualquer classe, clicando duas
vezes sobre a barra de cor. O interessante ¢ testar
as cores de modo que haja uma disting¢ao clara entre
altitudes baixas e altas; por isso usualmente, como
dito anteriormente na introdugao, utilizam-se cores

“frias” para altitudes baixas e “quentes” para altas.
Nao se esqueca de salvar seu modelo de cores, caso
queira utilizd-lo em outros projetos; va a por¢do
inferior da aba em >Estilo >Salvar estilo (>Style
>Save style) (Fig. 20).
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Figura 20.

A segunda opciao de como atribuir um
gradiente colorido ¢ iniciar um novo mapa de cores.
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Figura 21.

Vocé pode também editar a cor e/ou
tonalidade das duas cores extremas em >Editar
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para iniciar o processo (Fig. 21).
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V4 na secdo “Gerar novo mapa de cores” (“Generate
new color map”) e escolha uma das paletas de cores

2 V] Rancer  @perscans @

(>Edit), bem como inverter o gradiente das mesmas
selecionando a caixa >Inverter (>invert) (Fig. 22).
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Figura 22.

Aseguir, vaem “Modo” (“Mode”) e selecione
>Intervalo igual (>Equal interval); Em “Classes”,
escolha a quantidade de classes de altitudes que
desejar incluir no mapa- vamos selecionar como
exemplo oito classes; clique em >Classificar

(>Classify) (Fig. 23). Note que no quadro de valores
ao lado esquerdo, as classes e cores escolhidas foram
atualizadas. Os valores irdo incluir sempre as altitudes
minima e maxima contendo intermediariamente o
numero de classes solicitadas em intervalos iguais.
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Figura 23.

A seguir, na secdo “Carregar Min/max”
(“Load Min/max”) escolha os mesmos parametros
que usados no exemplo da “primeira opcao”,
utilizando um modelo digital ja pronto; selecione

>Min/max e >Real (mais lento) (>Actual (Slower));
clique em >Carregar (>Load) e a seguir em >Aplicar
(>Apply) e >Ok (Fig. 24).
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Figura 24.

Caso nao tenha gostado das cores, ¢ possivel

trocar a paleta de cores e editd-las sem modificar

o restante dos parametros, exceto pelo nimero de
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classes, selecionando a paleta de cor desejada e
clicando novamente em >Classificar (>Classify)
(Fig. 25).
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Figura 25.

E interessante decidir as cores antes de
modificar os valores das classes, pois toda vez que
reclassificar, os valores voltardo aos originais. Neste
exemplo, perceba que os valores de altitudes mais
presentes no mapa (entre 0-1200 m) receberam
tonalidades diferentes para uma mesma cor, nio
resultando em um contraste adequado. Escolha

outras opcdes clicando duas vezes sobre a barra de
cores dos intervalos intermedidrios para criar um
gradiente mais informativo (contrastante) para a
regido de interesse (Fig. 26).

Ao final ajuste os valores de altitude que
deseja corresponder ao gradiente de cores clicando
duas vezes sobre o valor (Fig. 26); podemos usar
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de exemplo o modelo da “primeira opcao”, feito
anteriormente. Uma vez que todas as escalas de
altitude tenham uma cor atribuida, a edi¢do de
altitude do relevo esta pronta.

~

» Band rendering
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Figura 26.

Parte III - Interpolando Sombreamento de
Terreno 3D

Para atribuir um efeito mais realista ao
mapa hipsométrico, podemos criar uma camada de
representagdo 3D de sombreamento para o relevo
topografico, chamada de funcdo “Sombreamento”

(“Hillshade”). O que iremos fazer basicamente ¢
criar outra camada de relevo de sombreamento 3D
para interpor com a camada de relevo de altitude.
Para possibilitar este efeito, as unidades de medidas
das duas camadas Raster,
tanto o de latitude e
longitude (medida
horizontal) quanto a de
altitude (medida vertical)
devem ser a mesma,
nesse caso metros (m).
No caso da camada
“SRTM_W_250m.tiff”
que estamos utilizando
neste tutorial, as
coordenadas estdo em
UTM e por isso nao
sera necessario fazer a
correcao do “Fator Z”
(“Z-factor”)* - utilizado
para corrigir a escala
da unidade quando nao
estd em metro, como
por exemplo em graus
decimais.

Para exemplificar este tutorial iremos usar o
modelo digital de elevagdo elaborado na “primeira
op¢ao” (Altitude Continente.qml). Para criar a
camada de sombreamento v4 ao menu superior clique
em >Raster >Andlise de terreno >Sombreamento
(>Raster >Terrain Analysis >Hillshade) (Fig. 27).

Atribuaumnome de saida para o arquivo “.tif”
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Figura 27.

*Nota de rodapé: Na janela
“Sombreamento” (“Hillshade”)
insira a escala de correcio do
valor no “Fator Z” (“z-factor”):
111120. Este valor é aproximado
para regides equatoriais ou
proximos a elas. Caso a zona seja
outraénecessariocalcularatravés
de uma férmula especifica (z=1/
(111320*cos(latitude*pi/180));
http://www.gdal.org/gdaldem.
html, GDAL - Geospatial Data
Abstraction Library).
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de relevo 3D que sera gerado em “camada de saida”
(“output layer”) (Fig. 28). Nao modifique o restante
dos parametros. Como observado anteriormente,
ndo serd necessario corrigir o “Fator Z”. A cria¢ao

desta camada deverd demandar um periodo longo
de espera devido ao tamanho do arquivo Raster de
relevo.

Apoés criada a camada de sombreamento
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3D, arraste a camada “SRTM W _250m.tiff”,
posicionando-a acima da camada de sombreamento
3D de modo que possamos incorporar as
caracteristicas destas duas camadas em uma mesma

e ——— e
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Figura 29.
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imagem. No painel de camadas, clique com botdo
direito sobre a camada “SRTM W 250m.tiff” e
selecione >Propriedades (>Properties ) (Fig. 29).
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Na aba “Transparéncia” (“Transparency”), a camada de modo que permita evidenciar a camada
se¢ao “Tranparéncia global” (“Global 3D de sombreamento posicionada abaixo. Clique
Transparency”), atribua um grau entre 30-50% para >Aplicar (>Apply) e >Ok (Fig. 30).
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Figura 30.
Note a mudanga no mapa de relevo nao o sombreamento 3D. Faca uma aproximacgao de

e experimentalmente desmarque a camada uma determinada regido de interesse para observar
“Sombreamento 3D para observar a diferenca de com mais detalhe (Fig. 31).
profundidade dada ao terreno, quando usando ou
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Figura 31.
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SBI
E possivel ainda, editar o brilho e contraste

da camada “SRTM_W_250m.tiff” atribuindo uma
maior suavidade a imagem. Em >Propriedades
(>Properties) da camada, v4 na aba “Estilo”
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Figura 32.

Pronto! Seu mapa esta finalizado para seguir
para o compositor de impressao e incluir coordenadas,
linhas de grade e legenda. Nao se esqueca de salvar
seu projeto para que fique disponivel para um futuro
uso.

O ultimo detalhe a ser lembrado neste tutorial
¢ a insercao da legenda das classes de altitude que
vocé criou para seu mapa. Para isso, abra a tela

(“Style”), e na secdo “Renderizagdo da cor” (“Color
rendering”) aumente o brilho para um valor entre
35-60% e o contraste para 20% (Fig. 32).

- tutorial mapa_3D - 0

<~ H

de compositor de impressao clicando em “Novo
compositor de impressao” (“New print compositor”)
e adicione um novo mapa, de acordo com os passos
ensinados previamente no “Tutorial I”. Apds a
insercdo do mapa no compositor, clique no simbolo

de “Adicionar uma nova legenda” (“Add new
legend”) na barra de ferramentas superior ¢ insira-o
no compositor de impressao (Fig. 33).
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Em “Propriedades do Item” (“Item automatica” (“Auto-update”) e selecione todas as
properties”), va a se¢do “Itens da legenda” camadas que deseja remover da legenda; clique no
(“Legend items”), desmarque a opcao “Atualizagdo botdo de simbolo “-” para remové-las (Fig. 34).
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Clique duas vezes também sobre o nome da ou remova o titulo da legenda em >Propriedades
camada “SRTM_W_250m.tiff” e delete para que nao principais >Titulo (>Main properties >Title) (Fig.
aparec¢a na legenda (Fig. 35). Da mesma forma edite 36).

& QGIS 2.14.5-Essen - tutorial mapa_3D - 8
—u ~
BR tutorial2 -0
y /BB cElc : oy Atas. Setins
7 i BLORRbR amkhhee NHapp2 OF iBGEmAcRE SEEaEE
'“ Havy=xe P
"-‘ L\ Project home {20, J40 6o 8D | P00 pib P40 P6D  DBO . BO0 | |command hisory
Cwome et B B B8 B B B O B PV ] PP i o e 5 e B0 B0 B
= Favourites £ o aiied
ﬁa oy = Legend added
» 3 o E Change item position
. . =F Mg update changed
(=) P mssa 3 Legend item removed
@ orade : Legend item remaved
@ W rostars 'P' - m— -
% /£ spataiee i | Compostion = ltem properties Atias generation | Rems
=2 & ows Rerm properties
W | @wes = Legend
% ); WS E > Main properties
&E Tithe Legend
\": ] Title alignment Left -
\? Mop Map 0 =
k Wrap text on

[#] Resize ta fit contents

¥ Legend items
] Aute update Update all

Wia R =AY Y A

[ ] Only shaw items inside current atias feature

v

Coardinste -71.72,-25.40 & Scale 1:12.615.026 v | Rotstion 0,0 2| ¥ render € epscians @

Figura 35.



E Boletim Sociedade Brasileira de Ictiologia, N° 124

32

’

QGIS 2.14.5-Essen - tutorial mapa_3D

b

NEBRGA 4K A

R /& @ >

v ‘Browiser Fanel 8 )
p Byt F ‘ :
2 Project homa - = fio
;’n : CF:WI.ITI!ES
k 0/
» B wssau
- @ orace
] | W rostsis
@ # Spatialite =
= | @ows =
& | @ wes o=
,u 85 wrs E
gl P9 :
] Layers Fanel EE
Lrlaenvarman =
\B | vI[] tudo FE

¥ /A T.Santarem_Analisados Analisa . =
V] /A Tsantarem_Wao_Analisados N =

Compuser Edt View Layout Atlas Setongs
( Bengike
| o o B

R - O -

0]

=~ O EDG E d
MR @?*\%:‘f‘ o M 00 ¥ =8 o .

T vl 00T, eer R POV, oA PO

D T s
* TAltitude (m)
{EBe

{0 200

L 400 =
T o0 a
{E 1200

| 1600

| 2000

0 ¥:306.444 mm  y: 150.66mm  page: 1

195.341

62.00% v 1 item selected

Figura 36.

Complete as informagdes necessarias no seu
mapa, contempladas no passo-a-passo do “Tutorial
I” (N°118) e salve seu modelo de compositor
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exportando seu mapa na extensao que desejar.
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Geographic distribution maps
tutorial
Part II — Hypsometric Map

In a Dbiological context,
taxa distribution maps are usually
complemented with many abiotic

variables and data, in addition to the
collection localities of interest. An
example is the use of topographic
information, such as altitude, which
can be illustrated in maps, can be very
informative regarding geology and
geographic appearance.

Hypsometry is a representation
technique of landscape elevation through
a continuous color-gradient system.
“Cold” colors (e.g. green, blue tones) are
usually used to represent lower elevation
patterns, while “warm” colors (e.g. red,

orange tones) refer to higher elevation
patterns. Hypsometric data allows a
detailed exploration of the landscape of a
region of interest, allowing for inferences
of erosion patterns, floodplains, accidents
and depressions, for example.

A walkthrough tutorial
regarding the preparation of hypsometric
maps is herein presented. The referred
tutorial is complementary to “Tutorial -
Parte I’ (Maps tutorial part 1), previously
published in Portuguese in Boletim
da Sociedade Brasileira de Ictiologia
N°118. The following tutorial is designed
with the objective of representing and
personalizing elevation and landscape
data in a simple manner.

This hypsometric map tutorial
was eclaborated and tested using the
software Quantum GIS (QGIS) V. 2.14.5

mental Sciences, University of Toronto Scarborough, 1265 Military Trail,
MI1C 1A4, Toronto, ON, Canada. E-mail: jp.fontenelle@mail.utoronto.ca

and V 2.14.18. QGIS is open source and
can be downloaded for free at http:/
qgis.org. This tutorial was elaborated in
Portuguese and in English. The referred
figures in the English version are found
throughout the Portuguese version of the
tutorial, which is presented preceding the
English version.

The following tutorial is not
designed for a professional cartographic
use, but for educational purposes of
students, teachers, professors and
researches, and should not be used as
an exclusive source of information.
All programs and websites used in this
tutorial have copyright of their contents
and files, which are here properly cited
and its citation is recommended if further
utilized.
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Part I — Downloading core files

Step 1: Raster landscape files

Step one consists of learning
how to edit the map’s landscape layer,
adding different colors to respective
altitude categories and selecting which
and how many altitude classes are
desired to be represented on the map.

Raster files (.tif) of continuous
landscape, used to prepare the maps and
provided by “The CGIAR Consortium
for Spatial Information (CGIAR-CSI)”
geoportal, can be downloaded from
http://srtm.csi.cgiar.org/ (Fig. 1). When
clicking on the main link, you should
be redirected to a new page where the
global region of interest can be selected,
South America for this tutorial: click
on “Western” and download “western
GeoTIFF” (Fig. 2).

The CGIAR Geoportal hosts
files of digital elevation models of
landscape for the entire globe ‘SRTM’
(Shuttle Radar Topography Mission),
in a resolution of 250m, originally
produced by NASA. These data are
currently of open distribution by USGS
(U.S. Geological Survey; https:/viewer.
nationalmap.gov/launch/) online, and are
available for download at “National Map
Seamless Data Distribution System” or
the USGS website (https:/nationalmap.
gov/viewer_text.html) (Fig. 3).

Alternatively, if one is
interested in working with a specific
geographical region in a broader scale
(not the scope of this tutorial), date
can be obtained from the TOPODATA
project (Brazilian geomorphological
database; INPE, 2008), which provides
the “Digital Elevation Model - DEM)
and their local Brazilian derivations,
elaborated from SRTM space data, after
many inspections and improvements
(due to gaps that occurred in the original
data by interferences during the data
collection process — example of gaps and
corrections: goo.gl/FHcgFA). Individual
data can be downloaded from INPE at
http://www.drs.inpe.br/topodata/acesso.
php (Fig. 4) or at Webmapit http://
www.webmapit.com.br/inpe/topodata
(Fig. 5), selecting the desired grid. The
elaboration process of a map with re-
scaling of altitude categories is more
complex and is not approached in this
tutorial, but can be easily found online
by searching for “hypsometric maps”.

Step 2: Altimetry model file

In order to simplify the
elaboration of a simple geographical
distribution map with landscape editable
altitude information, a pre-existent
elevation digital model will be used.
These models are produced by http:/
www.webmapit.com.br and can be
downloaded for free at http:/blog.
webmapit.com.br/2013/02/topodata-
paletas-qggis-para-altitude.html. Files
with the extension “.qml” are models
that categorize color ramps to variable
altitude, and were developed by
Webmapit from SRTM’s elevation values
and color rules: Terrain, Atlas Shader
and ETOPO2; from GRASS software
(Function ‘r’, colors) (Webmapit,
accessed Nov/2017). Additionally, two
other models (developed by the authors),
one in brown tones and other developed
during this tutorial, are available at (goo.
gl/7iPg2L) or at http://www.barbara-

calegari.com.

Part II — Creating a
Hypsometric map

Using a geographical
distributional map assembled according
to “Tutorial I’ (SBI N°118) as a starting
point, except by the addition of the
landscape file (Fig. 6), move directly to
the second stage of the landscape layer
edition.

To add a landscape file from a
Raster source, click on the second icon
on the toolbar to the left of the screen

¥, as shown in “Tutorial I” (Fig. 7).

Browse your drive for the
location of the previously downloaded
Rasterlandscape file>SRMW_W_250m.
tiff. Move the landscape layer to the
bottom position of your layer pile, so it
does not overlap any of the other layers.
Right-click the recently added landscape
layers “SRTM_W 250m” and go to
>Properties (Fig. 8).

In the “Style” tab, find the
session “Band rendering” (Fig. 9), where
many color settings can be edited, and
where most of the tutorial will take part.
Notice that the added landscape layer
is currently in grayscale, presenting
no hypsometric information yet. It is
necessary to include a proper color ramp
to highlight the map topography. There
are two options to attribute colors to
altitude classes, but both require selecting
the option >Singleband pseudocolor,
under “Render type”, which allows
including color scales to the map. (Fig.

10). Also select the option >linear under
“color interpolation”, allowing a gradual
soft change in colors related to altitude
(Fig. 11).

The first option (more intuitive)
is to edit the color gradient from a pre-
existent digital elevation model; choose
one from the six models previously
downloaded in Step 2: Altimetry Model
file. Load the files at the lower portion of
your window under >Style>Load style.
The editable landscape models have a
“.qml” extension (Fig. 12).

You can check every file, and
select the one which color scheme pleases
you the most. To edit, the example will
use the file “Altitude Continente.qml”,
developed for this tutorial (Fig. 13).

After selecting the model, go
to the option “Load min/max value” and
select >Min/max, in order to set the two
altitude extremes; also go to “Accuracy”,
select >Actual (slower), in order to show
the real landscape altitudes. Click > Load.
This step may take a while, depending
on your hardware specifications. Once
done, you can click >Apply to visualize
the edits made (Fig. 14).

You can modify all the altitude
classes you deserve to include in your
map, managing gradients. It will be
included, in this example, one additional
100m class; under the white box that
shows altitude values, click on “+” to
add a new value to the map (Fig. 15).

Note that the new value was
added to the end of the list, in a random
color scheme. To add the desired color to
the altitude value, double-click the value
(expressed in meters) and edit it, always
keeping the decimal series to zero
“.00000”, according to the remaining
values. Include a color to the altitude
scale of 100 m and then click on the
symbol “V” so the values are re-ordinated
in ascending order (Fig. 16).

Click on the color to edit it, and
choose the desired color and tone, green
in this example (Fig. 17). Additionally, it
is necessary to edit the “Label” to show
the correspondent altitude to the inserted
class (“100” in the example) (Fig. 18).
One option is to include the altitude
interval (e.g. 100-200m) to all classes,
in contrast to the minimum value. Click
in >Apply and >Ok. In order to delete,
select the desired class and click the
symbol “-” (Fig. 19).

It is also possible to alter any
color of any class, by double-clicking
over the color bar. It is interesting to
maintain a clear distinction between
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lower and higher altitudes, so it is
suggested to use “cold” color tones for
lower altitudes and “warm” color tones
for higher altitudes. Do not forget to
save your color model, for further use
if desired: go to the lower portion of the
window in >Style >Save style (Fig. 20).

The second option to create a
color gradient is to start a new map from
scratch. Go to “Generate new color map”
session and choose one from the color
palettes (Fig. 21).

You can also edit the color
and/or tone of the two extremes of your
gradient in >Edit, as well as invert the
referred gradient by selecting the box
>Invert (Fig. 22).

Next, go to “Mode” and select
>Equal interval. In “Classes”, select
the amount of altitude classes you
would like to include in the map (eight
classes will be chosen for this example);
click in >Classify (Fig. 23). Note in the
values box on the left side of the screen
that the chosen classes and colors were
updated. The values will always include
the minimum and maximum altitudes,
with the number of selected classes in
between, in equal intervals.

In the “Load min/max” session,
choose the same parameters used in the
“first option”, making use of a pre-
existing digital model. Select >Min/max
and >Actual (slower); click on >Load
and then in >Apply >Ok (Fig. 24).

If desired, it is possible to
change and edit the color palette without
modifying the remaining parameters,
except for the number of classes, by
selecting the desired color palette and
clicking on >Classify (Fig. 25).

It is interesting to choose and
edit the colors before modifying the
class values, once every time you “re-
classify” your project, the values return
to their default. In this example, note that
the most common altitude values in the
map (0-1200m) were attributed different
tones of a same color, not presenting an
adequate contrast. Choose other options
by double-clicking the color bar of the
intermediate intervals in order to create
a more informative (contrasting) color
gradient to the region of interest (Fig.
26).

Lastly, adjust the altitude
values that you want to correspond to
the color gradient by double-clicking
over the value (Fig. 26); the model used
in the “first option” can be used as an
example. Once all the altitude scales
have one assigned color, the landscape

altitude editing is completed.

Part III — Interpolating 3D
landscape shading

To create a more realistic
effect on the hypsometric map, a 3D
shading representation layer for the
topographic map can be created, using
the function “Hillshade”. This consists
of basically creating a new 3D shading
layer and interpolate with the landscape
altitude layer. To achieve this effect,
the measurement units of both Raster
layers, latitude and longitude (horizontal
measurements) and altitude (vertical
measurement), must be the same, in
this case, in meter (m). Considering the
layer “SRTM_W _250m.tiff” (being used
in this tutorial), the coordinates are in
UTM, so there is no need to correct the
“z-factor” (*footnote) — used to correct
the scale units when not in meters (e.g.
when in degrees).

In this example, the digital
elevation model produced in the
“first option” will be used (Altitude
Continental.qml). To create the shading
layer, in the upper menu, click on >Raster
>Terrain Analysis >Hillshade (Fig. 27).

Assign an output name to the
3D landscape “.tif” file which will be
generated in the “output layer” field
(Fig.28). Do not modify the remaining of
the parameters. As previously noticed, it
is not necessary to correct the “z-factor”.
The processing/creating time of this
layer may be long (depending on your
hardware) due to the size of the landscape
Raster file.

Once the 3D Hillshade layer is
created, drag the “SRTM_W _250m.tiff”
layer to the position right above the 3D
shading layer, in order to incorporate
characteristics of both layers into a single
image. In the layers panel, right-click
over the “SRTM_W_250m.tif” layer and
select >Properties (Fig. 29).

On the “Transparency” tab,
assign a transparency percentage to the
layer around 30-50%, so it is possible to
visualize the 3D shading layer that is set
below. Click >Apply >0k (Fig. 30).

Note the change in the landscape
map and, as an exercise, uncheck the
Hillshade 3D layer to observe the
changes in depth related to the terrain,
when using or not the 3D shading layer.
Close up to a region of interest to observe
in greater detail (Fig. 31).

It is also possible to edit
brightness and contrast of the

“SRTM_W 250m.tiff” layer, in order
to increase the smoothness of the image.
In the >Properties of the layer, go to the
“Style” tab and in the session “color
rendering” increase brightness to a value
around 35-60% and contrast around 20%
(Fig. 32).

The map is now ready to the
print composer, to include coordinates,
gridlines and legends. Do not forget to
save your project for future usage and
editing.

The last detail of this tutorial is
the inclusion of the legend regarding the
altitude classes that have been created for
the map. Click on “new print composer”
and add a new map to the print composer
canvas, as presented in “Tutorial I”.
After the new map is inserted, click on
“Add new legend” at the upper toolbar
and insert it on the print canvas (Fig. 33).
In “Item properties”, go to “legend
items”, de-select the ‘auto-update”
option and select all layers that you wish
to remove from the legend. Then click
the “-” button to remove them (Fig. 34).
Double-click on the name of the
“SRTM_W_250m.tif” layer and delete it
so it does not appear on the legend (Fig.
35). You can edit or remove the title of
the legend in >Main properties >Title
(Fig. 36).

Complete the relevant
information to your map, as presented
in “Tutorial I” (N°118), and save your
composer model by exporting it using
the desired extension.

Cited/accessed websites:
https://viewer.nationalmap.gov/launch/
http://srtm.csi.cgiar.org/
http://gisweb.ciat.cgiar.org/ TRMM/SRTM _
Resampled 250m/
http://www.dsr.inpe.br/topodata/acesso.php
http://blog.webmapit.com.br/2013/02/topodata-
paletas-qgis-para-altitude.html
http://www.processamentodigital.com.
br/2012/01/02/grass-6-4-preenchimento-de-
vazios-do-srtm3-atraves-dos-algoritmos-r-
mapcalc-e-r-fill/

http://www.gdal.org/gdaldem.html

*footnote: On the “Hillshade” window, insert the
correction scale of the value in the “z-factor” field:
111120. This is an approximate value to regions
around the Equator . If working with a region not in
this area, it is necessary to calculate “z” using the
formula: z=1/(111320*cos(latitude*pi/180) (http:/
www.gdal.org/gdaldem.html, GDAL - Geospatial
Data Abstraction Library).




